
INNOVA

User Manual
for

Application Software Type 7300

From serial number: 1 525 786

December 2003

BB 6004 – 12

BB600412.book  Page 1  Saturday, January 10, 2004  1:03 PM



Trademarks

Windows and Excel are trademarks of Microsoft Corporation
Windows98, NT, Windows2000 and Access are registered trademarks of
Microsoft Corporation

Copyright © 2003 Innova AirTech Instruments A/S

All rights reserved. No part of this publication may be reproduced or distrib-
uted in any form, or by any means, without prior consent in writing from
Innova AirTech Instruments A/S, Ballerup, Denmark.

Safety Considerations
Warnings
• Switch off all equipment before connecting or disconnecting

them. Failure to do so could damage the equipment.

• Never switch off the computer when using the Type 7300.
Switching off can damage the database.

About this User Guide
This user manual is structured to guide the first-time user step by
step through setting up the measurement system, and using the
7300 to control the system. The table of contents at the front of this
guide shows clearly where the information in this user guide can
be found. The index at the back enables the user to go directly to
the relevant sections when difficulties arise. 

Throughout this User Manual, references are made to Innova Air-
Tech Instruments. So as not to write a long list each time, the 1312
Photoacoustic Multi-gas Monitor is quoted. However, the 1412 Pho-
toacoustic Field Gas-Monitor, 1314 Photoacoustic Mult-gas Monitor,
Multi-gas Monitor Type 1302, Single-gas Monitor Type 3425 and
Dual-gas Monitor Type 3426 can also be used in these applications.
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This chapter tells you:

● How to install a National Instruments IEEE 488 interface
in your computer

● How to fit the 7300 Security key to the computer

● How to load the 7300 into the computer

1.1 Installing a IEEE 488 Interface

As well as being able to communicate with the 1312 and 1303(s),
or 1309, over the RS–232 interface, the 7300 can also commu-
nicate with them over the IEEE 488 interface, using the following
recommended interface board and driver:

National Instruments IEEE 488 interface and Software
GPIB-PC2A for Windows 

For installation of the interface board and software, use of the
configuration program WIBCONF and definitions of parameters
refer to the manual supplied with the interface. Please note that
the following parameters are recommended when installing and
setting up the interface board.

Device map and device names:

The device names used for the 1312 and, 1303(s) or 1309 on the
interface board's device map in WIBCONF must be BK1302,
BK13031, and BK13032.

Note: if only one multiplexer is connected use BK13031.

Note: Before installing the interface board and software, change
the 1312 set-up to IEEE communication. For more details about
this procedure, refer to the 1312 Instruction Manual.
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GPIB0 board characteristics (interface board and GPIB-
PC2A software):

Device characteristics for BK1302, BK13031 and BK13032:

Primary GPIB Address 0
Secondary GPIB Address None
Timeout setting 10 sec
EOS byte 10H
Terminate Read on EOS Yes
Set EOI with EOS on Writes Yes
Type of compare on EOS 7-bit
Send EOI at end of Write Yes
System Controller Yes
Assert REN when SC Yes
Enable Auto Serial Polling No
Bus timing 500 nsec
Parallel Poll Duration Default
Board Type PC2A
Interrupt level setting As on board — Default: 7
Base I/O Address As on Board — Default: 02E1
DMA channel As on board — Default: 1

Primary GPIB Address In accordance with the device’s 
address number

Secondary GPIB Address None
Timeout setting 10 sec
Serial Poll Timeout 1 sec
Terminate Read on EOS Yes
Set EOI with EOS on Write Yes
Type of compare on EOS 7-bit
EOS byte 10H
Send EOI at end of Write Yes
Enable Repeat Addressing No
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1.2 Fitting the Type 7300 Security Key

Warning! Switch off all equipment before connecting or discon-
necting the interface cable or the Type 7300 Security Key. Fail-
ure to do so can damage your instruments and the computer.

The Security Key is a protection device that you attach directly
to LPT1, the first parallel port of your computer. It ensures that
only authorized owners can use the 7300. Without the key the
7300 cannot be used to make measurements.

Note: that the security key must be used even if you are using
the IEEE interface to communicate with your system. If you are
using printers that are connected to the parallel port, the secu-
rity key must be connected to the port. The printer cable must
be connected to the security key.

To fit the 7300 security key to the computer:

1. Switch off the computer.

2. Locate the computer’s parallel port. If you are not sure which
port this is, refer to your computer’s instruction manual. 

Push the Security Key directly onto the parallel commu-
nication port (LPT1) of the computer, and tighten the
screws fitted to the security key to secure it to the screw-
fittings of the port.

NOTE: LOST SECURITY KEYS WILL NOT BE REPLACED
BY INNOVA AIRTECH INSTRUMENTS.

1.3 Install the 7300 in the Computer

Important! It is recommended to make a backup copy of the
existing databases before installing the 7300.

Note: Your existing databases will not be deleted when you
uninstall your current software version. See section A.4 for de-
tails on how to use your existing databases.
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Hardware requirements for the 7300 software:

● Pentium II (333MHz) processor

● Minimum 20 MBytes of free space available on the hard disk

● Minimum 128 MBytes of RAM

● One serial port (RS–232) and one parallel port

or 

One GPIB IEEE port and a parallel port

● Mouse

Software requirements for the 7300 software:

● Windows 98, NT 4.0 (SP 6 or above), or Windows 2000 (SP 1
or above) installed

Installing 7300 on a PC

Note: it is recommended to close all Windows programs that are
open before starting the installation.

Install 7300

Insert the CD labelled “Type 7300”, version 4.0 or above in
the PC. The setup starts automatically.

Follow the prompts given on screen to guide you through
the installation.

When the installation is complete, a program group is cre-
ated, “INNOVA AirTech Instruments”, which contains the
7300 icon.
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Connecting Up the 1312 & 1303(s) 
or 1309

2.1 Connecting the 1312 and 1303(s) or 1309 
to the Computer's RS – 232 Ports...................................2 – 2

2.2 Connecting the 1312 and 1303(s) or 1309 
to an IEEE488 Interface Port..........................................2 – 3

2.3 Connecting Tubing to the 1312 and 1303(s) 
or 1309 ........................................................................................2 – 4
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This chapter tells you:

● How to connect the 1312 and, 1303(s) or 1309 to the com-
puter's RS – 232 communication port, or to an IEEE 488 in-
terface port (if one is installed in the computer)

● How to connect tubing to the 1312 and, 1303(s) or 1309

2.1 Connecting the 1312 and 1303(s) 
or 1309 to the Computer's RS – 232 
Ports

Check if your computer's communication port is 25-pin or 9-pin,
then use the following text to decide which INNOVA cables to
use for connecting the instruments to the computer:

Connecting to a 25-pin COM port: Cable WL0946 (25-pin to
25-pin RS – 232)

Connecting to a 9-pin COM port: Cable WL0945 (25-pin to
9-pin RS – 232)

Connecting the 1312 and 1303(s) or 1309 together (IEEE to
IEEE): Cable AO0265 (2m) or WL0845 (0.4m)

To connect the instruments to the computer:

1. Ensure that the computer and instruments are switched off
before making any connections.

2. Using the appropriate cable, push one end onto the compu-
ter’s COM port, and tighten the screws fitted to the cable
to secure the connection.

3. Attach the other connector of the cable to the RS – 232 in-
terface port on the rear panel of the 1312.

Connecting 1303(s) or 1309 to the 1312:

1. Push one connector of Cable AO0265 (2m) or WL0845 (0.4m)
into the IEEE interface port on the rear panel of the 1312,
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and tighten the screws. Push the other connector of the cable
into the IEEE interface port of the 1303 or 1309 and tighten
the screws.

2. If you have two 1303 units, connect the second cable, AO0265
(2m) or WL0845 (0.4m), to the back of the connector mounted
on the first 1303 unit. Then connect the other connector of
the cable into the IEEE interface port of the second 1303
and tighten the screws, as before.

2.2 Connecting the 1312 and 1303(s) 
or 1309 to an IEEE488 Interface 
Port

To do this, you need the following INNOVA cable:

Connecting the computer to the instruments: Cable AO0265

Connecting the 1312 and 1303(s) or 1309: 1 or 2 Cables AO0265
(2m) or WL0845 (0.4m)

To connect the instruments to the computer:

1. Ensure that the computer and instruments are switched off
before making any connections.

2. Insert the connector of Cable AO0265 into the computer's
IEEE interface port, and tighten the screws fitted to the
connector to secure the connection.

3. Push the connector at the other end of Cable AO0265 into
the 1312's IEEE interface port, and tighten the screws.

4. Push one connector of Cable AO0265 onto the back of the
connector already mounted on the 1312's IEEE interface
port and tighten the screws. Push the other connector of the
cable into the IEEE interface port of the 1303 or 1309 and
tighten the screws.
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5. If you have two 1303 units, repeat the procedure given in
step 4, connecting the second cable to the back of the con-
nector mounted on the first 1303 unit.

2.3 Connecting Tubing to the 1312 
and 1303(s) or 1309

All of the sampling procedures which the 1312, 1303 and 1309
perform are done via tubing. From each individual measurement
location, a tube leads to the 1303's or 1309’s sampler channels,
so that gas-samples can be drawn from each location ready for
delivery to the 1312. The 1303 or 1309 is connected to the 1312,
so that the gas-samples can be delivered for analysis.

A full description of how to connect all necessary tubing to the
1312, 1303(s) and 1309, and what kind of tubing to use, is given
in the Instruction Manuals for the 1303 and 1309.
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BB600412.book  Page 1  Saturday, January 10, 2004  1:03 PM



Chapter 3 – Getting to Know the 7300
Getting to know the 7300

3 – 2 INNOVAApplication Software Type 7300
User Manual

This chapter tells you:

● How the 7300 is structured, and the philosophy of using the
7300

3.1 Getting to know the 7300

This section is for inexperienced users of the 7300. It gives a
brief introduction to the philosophy of using the 7300. As such,
full details of using the 7300's functions are not given in this
section. More experienced users should go to Chapter 4 of this
manual.

Note: although the dialogues for the different Windows versions
appear slightly different, the procedures to and the information
from them are the same.

3.1.1 Data Display Windows

Measurement data and operating-status data from the instru-
ments are displayed in the 7300's data display windows. The
commands which open these windows are grouped in the View
menu. There are four types of data display window: the graphic
window; the numeric window; the status window; the notepad
window. A short introduction to each type of window is given
below.

The graphic window.

The graphic window is shown in Fig.3.1. The data displayed can
be measurement data (gas-concentrations, temperature, data
from external programs), or processed data (weighted/unweight-
ed averaged data). Up to 6 curves of data can be plotted simul-
taneously on the same axes. In addition, key values calculated
from the data can be displayed.

You make the graphs by using the mouse to click on the buttons
in the "panel" at the left of the screen. If not on the screen, the
panel is displayed using the Show Panel function in the View
menu. As default, the panel is displayed. The buttons activate
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dialogues in which you choose the type and style of curve to be
plotted. When the curves are plotted, you can use the data on
the curves to calculate a range of statistical and ventilation
parameters, which can be displayed in the panel at the top of
the screen.

The graphic window can be displayed in two forms. The first
form, “Fit to Window”, is an overview of the whole graph, which
excludes the measurement information. The size of the graph
stays the same relative to the size of the graphic window. This
is the default display form.

The second form, selected using Fit to Paper, includes informa-
tion about the measurement, and can be thought of as a page
of information. To see all of this form, you must use the scroll
bars to move the page. This form can be printed/plotted. You can
alter the size of the page using the Printer Setup function in
the File menu. You can also change the size and typeface of the
text on the page using the Font function in the Set-up menu –
see section 5.5.

Fig.3.1 The graphic window
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The x-axis of the graph is always a time axis. The units for the
y-axis depend upon the data plotted on the graph – see section
5.1.1.

The numeric window.

The numeric window is shown in Fig.3.2. The data is displayed
in table form, with each measurement marked with the time at
which it was made. The data displayed can be measurement
data (gas-concentrations, temperature, data from external pro-
grams), or processed data (weighted/unweighted averaged data).

The numeric window also has two forms, and unlike the graphic
window, both these forms can be printed/plotted. The first form,
“Disable Scroll” includes measurement information. The size of
the page can be changed using the Printer Setup function in
the File menu, in the same way as the graphic window. The
second form, “Enable Scroll”, allows you to scroll through the
measurement results using a specific scroll function.

Fig.3.2 The numeric window
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You select the data to be displayed in the numeric window by
using the buttons in the "panel" at the left of the screen. The
panel is displayed using the Show Panel function in the View
menu. One set of data, that is, data from one measurement
channel, can be seen at one time.

The status window.

The status window is shown in Fig.3.3. The window shows what
type of measurement is currently being performed (top section
of the window), and informs you if any operating warnings oc-
curred in the 1312, 1303(s), 1309 or the 7300. If you are in
monitoring mode, and an alarm-level is exceeded, the Status
window opens on your screen automatically so you can see the
data on the alarm situation. This window is also used to shut
off alarms that have been triggered.

The status window can also display the most recent measure-
ment results from a chosen measurement channel (lower section
of the window). You choose the measurement channel from a
dialogue, activated by clicking the mouse button in the Select

Fig.3.3 The status window
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Channel box. The most recent results from that channel will
then be displayed, with each new result replacing the previous
one.

The notepad window.

The notepad window is shown in Fig.3.4. It is used for storing
information that you want to save. The text in the notepad
window is stored in the database that you are currently using
– a very useful feature as it allows you to store notes on set-
ups, and other details. For more information, see section 5.4.

Fig.3.4 The notepad window
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This chapter tells you:

● How to make/open a database to receive the data from the
measurement you will be performing

● How to configure the 7300 to the instruments in your meas-
urement system, and set the system's communication pa-
rameters

● How to use the 7300 to set up and perform the measure-
ments you want

● How to use data from an external program in the 7300

This chapter is structured to guide you, in the correct sequence,
through setting up and starting measurements. When you have
completed one section, the next section tells you what you should
do next. Sections 4.1 to 4.3 deal with making and opening a
database, and configuring the 7300 to the instruments. Section
4.4 deals with setting up the measurement. Section 4.5 tells you
how to start measurements.

For information on backing up, restoring, deleting, exporting and
importing data, see Appendix A.

4.1 Making, Opening and Closing a 
Database

Before configuring the 7300 to the measurement system, setting
up and starting a measurement, you must first open a database
in which the data from the measurement can be stored. This is
done using either the New or the Open function in the File
menu. The New function makes a new database. The Open
function opens an existing database, and simply adds data from
the “new" measurement to the data already in the database.

Note: you cannot use the New or Open functions when a da-
tabase is already open. You must use the Close function in the
File menu. Quitting the 7300 closes databases automatically.
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To close a database that is open:

1. Pull down the File menu. Click on Close. The Close Data-
base dialogue will be displayed.

2. Click on OK to close the database.

To make a new database:

1. Pull down the File menu. Click on New. The New Database
dialogue will be displayed, Fig.4.1.

2. Type in the name you want for the database (max. 8 char-
acters).

3. Click on OK to make and open the new database.

If a database already exists with the name you have typed, an
alert will be displayed to tell you this. In this case, repeat the
above procedure, using a different name.

Fig.4.1 The New Database dialogue
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Parameters in a new database take on the values they had in
the previously opened database with the following exceptions:

● The file names in the User dialogue take on their default
values.

● The printer type in the Printer dialogue takes on its default
value.

Therefore, if you want to make a new database (e.g. NEWBASE)
similar to one which already exists (e.g. OLDBASE):

1. Open the database (OLDBASE) you want to base your new
database on with Open.

2. Close this database with Close.

3. Make your new database (NEWBASE) with New.

NEWBASE is now the same as OLDBASE except for the User
dialogue file names and the printer in the Printer dialogue which
have their default values.

To open an existing database:

1. Pull down the File menu. Click on Open. The Open Data-
base dialogue will be displayed, Fig.4.2.

2. Locate the database file-name you require by using the scroll
arrows at the top and bottom of the list of database files.
Click on the file-name to highlight it.

3. Click on OK to open the highlighted database file.

If you want to view the data, see Chapter 5. 

4.2 Setting the Configuration 
Parameters

The Configuration function in the Set-up menu configures the
7300 to the instruments in the measurement system, and selects
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the communication channel between the computer and the in-
struments.

Note: if you are using the IEEE interface between the computer
and the 1312, ensure that the 1312 is not set up as the system
controller of the IEEE interface. Refer to the 1312's Instruction
Manual for details of how to check this.

To configure the 7300 to your system:

1. Pull down the Set-up menu. Click on Configuration. The
System Configuration dialogue will be displayed, Fig.4.3.

2. Click on the communication interface port you are using
between the computer and the 1312 — either IEEE,
COM 1, or COM 2.

3. Select the type and number of sampling units you are using
by clicking in the boxes in the Connected Multiplexers field.

4. Click on OK to store the new configuration.

The configuration you have chosen will be stored by the 7300. 

Fig.4.2 The Open File dialogue
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4.3 Setting the Communication 
Parameters

The Communication function in the Set-up menu sets the
parameters for communication between the computer and the
1312/1303(s) or 1312/1309. If you are using the IEEE interface
in your system, then you must type in the device addresses of
the 1312 and 1303 or 1309 units. 

The recommended parameter settings are:

IEEE Addresses

Fig.4.3 The System Configuration dialogue

Instrument IEEE Address

1312 14

First 1303
1309

15
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RS – 232 Communication (default values)

Note: if you are using the RS–232 interface, you must ensure
that there is no IEEE cable connected between the PC and the
1312, and you must set the 1312 so that the values for the baud
rate, parity, data bits and stop bits agree with those set in the
7300. Refer to the 1312 Instruction Manual for details of the
RS–232 communication parameters and the 1312's IEEE device
address; and to the 1303 or 1309 Instruction Manual for details
of the 1303's or 1309’s IEEE device address.

Note: the 7300 automatically sets the 1312 to Switched line and
Hard-wired.

Note: if you are using the IEEE interface between the computer
and the 1312, ensure that the 1312 is not set up as the system
controller of the IEEE interface. Refer to the 1312 Instruction
Manual for details of how to check this.

To set the communication parameters for a system using the
IEEE interface:

1. Pull down the Set-up menu and click on Communication.
The Communication Set-up dialogue will be displayed,
Fig.4.4.

Note: the Selected Communication field will show IEEE, and
the baud rate, Data Bits, Parity and Stop Bits will be grey,
showing that they are unavailable.

Second 1303 16

Baud Rate 9600

Data Bits 8

Stop Bits 2

Parity none

Instrument IEEE Address
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2. Type in the correct device addresses for the 1312, 1303 and
1309 units. Note that each must have its own unique ad-
dress. The device addresses for the 1303 and 1309 units are
set using the switches on the back panel, see the Type 1303
or 1309 Instruction Manual for full details.

3. Click on OK to store the communication parameters.

To set the communication parameters for a system using the
RS–232 interface:

1. Pull down the Set-up menu. Click on Communication. The
Communication Set-up dialogue will be displayed as shown
in Fig.4.4.

2. Click on the values for Baud rate, parity, data bits and stop
bits that are set in the 1312. Also set up the device addresses
for the 1312, 1303 and 1309 units, as described in step 2
for communication parameters for a system using the IEEE
interface.

3. Click on OK to store the selected communication parame-
ters.

Fig.4.4 The Communication dialogue
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4.4 Multipoint Monitoring Tasks

Multipoint monitoring tasks are for monitoring gas-concentra-
tions in several locations simultaneously. These measurements
use only the sampler systems of the 1303 units. The general
procedure for performing multipoint monitoring tasks is as fol-
lows:

● Set up the 1312 for the gases you will be measuring

● Set up the 1303/1309 unit(s) by selecting which sampling
channels you will use in each measurement location

● Set up alarm limits for each gas you will be monitoring

Each of these steps is described in turn in the following sub-
sections.

4.4.1 Setting Up the 1312

The Monitor function in the Set-up menu lets you set up your
1312 for the measurements you want to perform. You choose how
many gases the 1312 will measure, the sampling interval, and
if the 1312 should perform water- and cross-compensation.

Note: values displayed in the 1312 Setup dialogue will be down-
loaded to your monitor when a measurement is started. There-
fore, it is recommended that you ensure that the settings and
values displayed in this dialogue are correct.

If you are not using 1303 or 1309 units, refer to section 4.4.3
for details of how to set alarm limits and select alarm relays.

To set up the 1312:

1. Pull down the Set-up menu. Click on Monitor. The Monitor
Set-up dialogue will be displayed, Fig.4.5.

Water compensation lets you choose if you want to compen-
sate for water-vapour interference in your measurements.

Cross compensation lets you choose if you want cross-com-
pensation for interferents.
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Normalization temperature is the temperature used to con-
vert the gas-concentrations unit mg/m3 to ppm.

Air pressure is the actual air pressure at the measurement
locations. (This is not displayed when a 1309 is used.)

Sample continuously lets you decide if you want the 1312
to begin a new measurement immediately after finishing the
previous measurement.

Sample interval sets the time-interval from the start of one
measurement cycle to the beginning of the next for the 1312. 

A, B, C, D, E, F and W represent the optical filter positions
of the 1312. Alongside each box are two text fields. The first
is for the name of the gas being monitored using that filter;
the second is for the molecular weight of the gas being
monitored.

Read lets you read-out the gas-names and molecular
weights resident in the 1312's memory.

Setup 1312... (only available when a 1312, 1314 or 1412 is
used) opens a new dialogue, see Fig.4.6.

Fig.4.5 The Monitor Set-up dialogue
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This dialogue allows you to change certain parameters,
which will be transferred to the 1312 when the 7300 starts
a measurement. These parameters are:

Flushing: there are two options Auto and Fixed Time.
Auto allows you to define the length of sample tubing.
The monitor then sets the flushing time automatically.
Fixed Time allows you define the flushing times for both
the measurement chamber and the sample tubing. The
default values are Chamber 8s and Tube 3s. The chamber
time can be less than the default (tube is fixed at 3s),
but the flushing error % increases.

Fig.4.6 The 1312 Set-up dialogue

Chamber 
Time (s)

Error %

3 2

4 0.8

8 0.25

BB600412.book  Page 12  Saturday, January 10, 2004  1:03 PM



Chapter 4 – Using the 7300
Multipoint Monitoring Tasks

BB 6004 – 12 4 – 13Application Software Type 7300
User Manual

Note: when a multiplexer is connected, only the Fixed
Time option is available, where the tube flushing is set
automatically.

Sample Integration Time (S.I.T): this allows you to define
the integration times for the sampled gases. There are
four settings: Fast (1s), Normal (5s), Low Noise (20s) and
Advanced. When Advanced is selected, the S.I.T for each
filter can be set individually. The values available are:
0.5, 1, 2, 5, 10, 20 and 50s.

Sample Integration Time Setup: this shows the S.I.T val-
ues for the selected filters. This is of particular interest
when the Advanced S.I.T option is selected.

For more details about these parameters, refer to the 1312
Instruction Manual.

2. Click in the Water compensation and Cross-compensation
fields if you want the 1312 to compensate for water-vapour,
and to cross-compensate for interferents.

3. If you want the 1312 to sample continuously, click in the
Sample continuously field. However, if you do not want con-
tinuous sampling, click on in the Sample interval field, and
type in the sampling interval (a value between 1 and 59
mins.) in the field below.

4. In the Normal temperature field, type in the temperature
used to convert the gas-concentrations unit mg/m3 to ppm.

5. In the Air pressure field, type in the air-pressure at the
measurement locations. (This is not displayed when a 1309
is used.)

6. Click on Read. All the names and molecular weights for the
gases entered in the 1312 memory are displayed in the
appropriate fields.

If the name is too long or you want another name, you can
edit it here. The new name will be stored in the 7300 data-
base, but it will not affect the 1312’s memory.

When reading out the names and weights from the 1312's
memory, you also check whether you can communicate with
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the 1312 over the interface. If they can't be read, check that
the cable is connected properly and that the addresses and
communication parameters are correct.

Note: filter position W is always for measuring water vapour.

7. Click in the boxes to select the filters you want to measure
with.

8. When using a 1312, 1314 or 1412, click on Setup 1312....
Define the Flushing parameter and the Sample Integration
Times for the selected filters. When you have set these pa-
rameters, click on OK. 

9. When you have set up the 1312, click on OK to store the
data.

The set-up you have made for the 1312 will be stored in the
7300's database.

4.4.2 Setting Up the 1303 or 1309 Units

The Multiplexer function in the Set-up menu lets you set up
your 1303 or 1309 units for the monitoring tasks you are to
perform. You choose which sampler channels will draw the sam-
ples from each measurement location.

To set up the 1303 or 1309 units:

1. Pull down the Set-up menu. Click on Multiplexer. The
Multiplexer dialogue will be displayed, Fig.4.7.

Sequence field allows you to select the manner in which the
active channels are sampled: 

Normal: samples the channels in the order shown in the
Current sequence field. When the last channel has been
measured, the multiplexer loops back to the first channel. 

Alarm: enables you to closely monitor channels where the
alarm limit has been reached. When an alarm is reached,
the sequence in the Current sequence field is overridden,
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every second measurement is now made on the channel
showing the alarm.

User: this allows you to define the measurement sequence,
using the Edit user sequence soft-key. When this soft-
key is pressed the following dialogue is displayed, see
Fig.4.8.

By highlighting the desired channel in the Active Chan-
nels: field, the Add soft-key can be used to create a user-
defined sequence. If you need to edit the list in the Current
Sequence field, highlight the desired entry in the list, this
can now be removed using the Remove soft-key or an
entry made in front of it using the Insert Before soft-
key. The Current Sequence field can have a maximum of
20 entries.

Select Channel allows select the sampling channel on the
multiplexer. If you are using one 1303 unit, only 6 channels
are available, while if you are using two 1303 units or one
1309 12 channels are available.

Channel Information allows you to make the channel shown
in the Select channel field active and provide this sample
channel with a descriptive label in the Location field.

Fig.4.7 The Multiplexer Set-up dialogue 
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Alarm lets you select the relay, beeper or speaker, through
which an alarm signal is sent.

2. Select the type of sampling sequence desired. 

If you are using the User option, use the Edit user se-
quence to define the sampling sequence. When the list is
complete, press OK and go to step 8.

3. Pull down the Select channel list and click on the desired
sampling channel.

4. Click on Channel Active to activate the channel

5. In the Location field, type in the name of the location from
which the selected sampling channel is taking samples.

6. In the Alarm field, click on the types of alarm you want to
use.

If you select 1312 Relay 1, any alarm signal will be sent via
that relay. If you select 1312 Relay 2, any alarm signal
caused by an upper alarm limit (see section 5.7.3) being

Fig.4.8 The User Sequence dialogue 
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exceeded will be sent via that relay. With 1312 Beeper or
PC Speaker, any alarm signal will be audible via the 1312
or the PC, respectively.

7. Repeat steps 2 to 6. for each sampling channel that you
want to use. 

8. When you have set up the 1303 or 1309 units for your
measurements, click on OK.

The set-up you have made for the 1303 or 1309 units will be
stored in the 7300's database.

4.4.3 Setting Alarm Limits

The Alarms dialogue in the Set-up menu lets you set alarm
limits for the gases you are monitoring. You can set an alarm
limit for each gas that you are monitoring. Using Alarm factor,
you can set a "warning" and a "danger" level, to notify you of
an increase in gas levels before it becomes dangerous. This dia-
logue also sets up the alarm relays that will be used to trigger
alarms when you are not using 1303 or 1309 units.

To set alarm limits:

1. Pull down the Set-up menu and click on Alarms. The
Alarms dialogue is displayed, Fig.4.9.

Alarm limits: these text fields on the right of the dialogue
contain the alarm limits for each named gas you are moni-
toring using each optical filter.

Alarm factor: lets you set a "warning" and a "danger" alarm
limit, in conjunction with 1312 alarm relays 1 and 2. If gas-
concentrations exceed one of the alarm limits that you have
typed-in, a signal will be given through 1312 alarm relay
number 1, the 1312 beeper or the PC speaker. If gas-con-
centrations exceed the alarm limit multiplied by the alarm
factor, a signal will be given through 1312 alarm relay
number 2. For example, if the "warning" level is 10 ppm,
and the "danger" level is 15 ppm, the alarm factor should
be 1.5. It is not possible to do this using the PC speaker
and 1312 beeper.
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Alarm for 1312 (No 1303): lets you select alarm relays when
you are using the 1312 without 1303 or 1309 units. If you
are using 1303 or 1309 units, you cannot use this function.

2. In each of the Alarm limits: text-fields, type in the alarm
limit for the named gas.

3. In the Alarm factor: field, type in the alarm factor. Note that
the alarm factor must be at least 1.0.

4. If you are not using 1303 or 1309 units, click on the type of
alarm you want to use in the Alarm for 1312 (No 1303): box.

5. When you have entered the alarm limits you require, click
on OK.

The alarm limits you have set will be stored in the 7300's data-
base. If one or more of these limits is exceeded, alarms will be
activated via the relays you have chosen.

Fig.4.9 The Alarms dialogue
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4.5 Starting Up and Stopping a Meas-
urement

When you have set up the measurement you want to perform,
you can start it. This is done with the Start function in the
Measurement menu. The Stop function stops a started meas-
urement.

Note: when you have started a measurement, many of the 7300's
functions cannot be used until the measurement is stopped.
These functions are written in the menus in grey type.

To start a measurement:

1. Pull down the Measurement menu and click on Start. The
Start Measurement dialogue will be displayed, Fig.4.10. You
can start a measurement immediately, or at a given date
and time.

2. To start a measurement immediately, click on Immediate.
To start a measurement at a fixed time. Click on Delayed,

Fig.4.10 The Start Measurement dialogue
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then type in the start date and time you require in the
respective fields.

3. Click on OK. According to your choice, the measurement
will start immediately, or the delayed-start time is stored
and the measurement started at that time.

When the measurement is started, the following text is shown
on the display of the 1312 Monitor: 

Now refer to Chapter 5 of this manual for details of how to see
your measurement results, using the 7300's data windows.

To stop a measurement:

1. Pull down the Measurement menu and click on Stop. The
Stop Measurement dialogue is displayed.

2. To stop the measurement, click on OK. If you have acciden-
tally selected this function, and do not want the measure-
ment to stop, click on Cancel.

4.6 Setting Up Units of Measurement

The Units dialogue in the Set-up menu lets you choose the units
of measurement that the 7300 will use when displaying data,
and in prints/plots of screens.

To select the units of measurement:

1. Pull down the Set-up menu. Click on Units. The Select
Units dialogue will be displayed, Fig.4.11.

REMOTE CONTROL BY 7300
MONITORING MEASUREMENT RUNNING
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2. Click on the units that you want to use.

3. Click on OK.

The units you have selected will be adopted for all screen
displays.

Fig.4.11 The Select Units dialogue
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This chapter tells you:

● How to use the data display windows of the 7300 to display
measurement results

5.1 Using the Graphic Data Window

The graphic data window displays data in graph form. You can
plot up to 6 curves on the same axes. The data you can plot can
be gas-measurement results, data from an external program, or
averaged data.

5.1.1 Setting up and Plotting Curves

The following text takes you step-by-step through plotting graphs
of your measurement results.

To set up the x-interval and style of the graph:

1. Pull down the View menu and click on Graphic window.
The Graphic window will be displayed in Fit to Window
mode, Fig.5.1.

A panel of "buttons" is displayed on the left side of the
graphic window. These buttons are dedicated to the graphic
window, and are used to set up the graphs you want to see
or plot. Show Panel is a toggle function: to remove the panel,
pull down the View menu and click on Show Panel.

2. Click on Graph Set-up in the panel. The Graph Parameters
dialogue will be displayed, Fig.5.2.

X-interval selects the time-period which the graph will cover.

Y-axis type selects if the y-axis will be scaled linearly or
logarithmically.

Grid mask selects the background to the graph: a crossed
(X-Y) grid; vertical lines (X); horizontal lines (Y); or no grid.

Grid style selects if the grid will be drawn in dotted lines
or solid lines.
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Y-scale lets you choose the type of y-axis: either showing
actual values (Off); or scaled from 0 to 1, with a scaling
factor and the unit of measurement displayed (On). The On

Fig.5.1 The graphic window

Fig.5.2 The Graph Parameters dialogue
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option is used when you have several different types of data
plotted on the same graph.

Resolution lets you choose the x-axis resolution of the graph
from 1 to 100%. 100% means that there is one point per
mm. 50% means that there is one point per 2 mm. 33%
means that there is one point per 3 mm. Thus, the resolution
of the x-axis is from one point per mm to one point per
100 mm.

3. In the first X-interval: From: field, type in the date from
which you want the graph's x-axis to start, in the format
YYYY-MM-DD. In the second X-interval: From: field, type in
the time from which you want the graph's x-axis to start,
in the format HH:MM:SS. Repeat this procedure to type in
the date and time at which you want the graph's x-axis to
finish, in the two X-interval: To: fields.

4. Choose the style of the graph by selecting the y-axis type,
grid mask and grid style, according to your requirements.

5. When you have entered the x-interval you require and cho-
sen the style of the graph, click on OK.

The Graph Parameters dialogue will disappear from the screen,
and the graph in the graphic window will be re-drawn in accord-
ance with the x-interval and style you have chosen.

Now you are ready to set up the curves to be displayed on the
graph.

5.1.2 Choosing Data to be Plotted and the Style of 
the Curves

1. Click on Data Select in the panel. The select data to show
on graph dialogue will be displayed, Fig.5.3.

The 6 text-fields on the left of the dialogue indicate which
of the 6 available curves you are setting up. These are also
used to activate the curves you want displayed. When you
have chosen the data you require, these text-fields show the
type of data you have selected. "W" and "UW" indicate the
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weighted and unweighted averages of the curve, respectively.
"+" and "–" indicate the maximum and minimum values of
the curve, respectively. For example, if you select data from
sampling channel 2, which is being used to measure Carbon
Dioxide, the text-fields for the curve you are setting up will
show 2 Carbon Dioxide. If you select data from a user
program, the text-fields for the curve you are setting up will
show the set-up text in the header file (see section B.2.1).
With a new database, the default data type chosen here is
Channel 1, Filter A.

Type selects the type of data you want to plot. The three
types of data are measurement results from each sampling
channel (Chan), data from a user program (User), and av-
erages of measurement results taken from two or more sam-
pling channels (Mean).

Data lets you select the actual data you want to plot as
curves. It displays a dialogue specific to the type of data you
want to plot (chosen in the Type field).

Color selects the color of a specific curve.

Line selects the type of line used for a specific curve.

Style selects the style of the curve. Choose between Line,
Step and Bar.

2. Click in a text-field to the left of the dialogue so that a
pointer is displayed in the box. This activates the curve, so
that you can select the type of data and the line-styles to
make this curve. The arrow also indicates which data can
be seen in the Numeric Data window — see section 5.2.

3. Select the color that you want for the curve by clicking on
Color. Select the line-type by clicking on Line and select
the line style: solid, dash, dot, dash dot, or dash dot dot.
Select the style of curve by clicking on either Line, Step,
or Bar.

4. In the Type field, click on the type of data to be plotted in
this curve — either Chan, User, or Mean. Then, click on
Data. This will display the Select Channel Data, Select User
Data, or the Select Mean Data dialogue, depending upon
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which type of data you want to plot. From these dialogues,
you choose the actual data to be plotted.

The use of each dialogue is explained in turn below.

The Channel Data dialogue

In the Select data to show on graph dialogue, select Chan and
then click on Data. The Channel Data dialogue is displayed, see
Fig.5.4.

Channel represents the sampling channels (therefore, the meas-
urement locations in which sampling is being done) of the 1303
or 1309 units. For 1309 units, box number 1 is sampling channel
number 1, and so on. While for 1303 units, box number 1 is
sampling channel number 1 of 1303 unit number 1, and so on.
Box number 7 is sampling channel number 1 of 1303 unit
number 2, and so on.

Location gives the name of the measurement location from which
each sampling channel takes its samples — see section 4.4.2.

Filter is the name of the gas measured by the filter.

Fig.5.3 The Select data to show on graph dialogue
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Filter lets you choose which data from the chosen sampling
channel (and therefore, measurement location) will be plotted.
You can choose: the gas-concentrations measured by the 1312
using a particular optical filter (represented by the boxes A to
W); or results from the temperature transducer at that meas-
urement location (represented by Temperature). The name of
the gas measured with the selected filter (defined in the 7300
setup) is shown next to Filter (top line).

Min gives the minimum value of the displayed curve (if com-
pressed or averaged).

Mean gives the average value of the displayed curve (if com-
pressed or averaged).

Max gives the maximum value of the displayed curve (if com-
pressed or averaged).

1. Click on the sampling channel number from which you want
data to be plotted.

Fig.5.4 The Channel Data dialogue
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The name of the measurement location that this selects will
be displayed in the Location field and the chosen gas shown
in the Filter field (top line).

2. Now select the data you want to plot from the chosen sam-
pling channel.

If you click on one of the boxes A to W, the data displayed
will be the gas-concentrations measured by the 1312 using
the optical filter you have chosen.

If you click on Temperature, the data displayed will be the
results from the temperature transducer at the chosen meas-
urement location.

3. When you have selected the data you want, click on OK.

The dialogue will be removed from the screen, and you will
return to the Select data to show on graph dialogue. The type
of data (gas-measurement, temperature measurement, etc.) you
have chosen will be shown in the text-field for the curve you
were setting up, on the left of the dialogue. The data you have
selected is now ready for plotting on screen.

The User Data dialogue

In the Select data to show on graph dialogue, select User and
click on Data. The User Data dialogue is displayed, see Fig.5.5.

Data Index represents the specific data from the external pro-
gram that you want to use.

1. Click on the index number to select the data you want to use.

2. Click on OK.

The dialogue will be removed from the screen, and you will
return to the Select data to show on graph dialogue. The type
of data you have chosen will be shown in the text-field for the
curve you were setting up, on the left of the dialogue. The data
you have selected is now ready for plotting on screen.
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The Select Mean Data dialogue

In the Select data to show on graph dialogue, select Mean and
click on Data. The Select Mean Data dialogue is displayed, see
Fig.5.6.

Filter: is the name of the gas measured by the filter.

Channels lets you select the sampling channels (therefore, the
measurement locations) from which measurement data will be
averaged. For 1309 units, box number 1 is sampling channel
number 1, and so on. While for 1303 units, box number 1 is
sampling channel number 1 of 1303 unit number 1, and so on.
Box number 7 is sampling channel number 1 of 1303 unit
number 2, and so on.

Filter lets you select which type of data will be averaged from
the sampling channels you choose. You can choose the gas-con-
centrations measured by the 1312 using a particular optical filter
(represented by the boxes A to W); or results from the temper-
ature transducer at that measurement location (represented by
Temperature). The name of the gas measured with the selected
filter (defined in the 7300 setup) is shown next to Filter (top line). 

Fig.5.5 The User Data dialogue
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Type lets you choose to weight the averaged results with the
volume of the measurement location chosen under Channels. 

1. You can also select the type of data you want to average:
the min, mean or max values of the selected data.

If you click on one of the boxes A to W, the data averaged
will be the gas-concentrations measured by the 1312 using
the optical filter you have chosen, from the sampling chan-
nels you select. 

You can weight these results for the volume of the measure-
ment location: click on Weighted. If you click on Temper-
ature; the data averaged will be the results from the
temperature transducer at the selected measurement loca-
tions.

2. Now select the channels from which you want to average
results, by clicking on the channel numbers.

For example, if you select channels 1, 2, and 3, and the type
of data you want to average is gas-concentrations measured
using filter A of the 1312, then the 7300 will calculate a

Fig.5.6 The Select Mean Data dialogue
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single set of average gas-concentrations from the three orig-
inal sets. The averages can then be plotted on screen.

3. Select min, mean or max.

4. Click on OK.

The dialogue will be removed from the screen, and you will
return to the Select data to show on graph dialogue. The
type of data you have chosen will be shown in the text-field
for the curve you were setting up, on the left of the dialogue.
The data you have selected is now ready for plotting on
screen.

You have now set up the first curve, ready for plotting. To plot
more than one curve, click in another text-field to display the
pointer in that field, and then repeat the above procedure, and
so on until you have set up all the curves you require.

To select a curve for plotting, ensure that its text-field is high-
lighted in the Select data to show on graph dialogue (white text
on a black background). Double click on the desired text-field
with the pointer to select the curve.

To de-select a curve so that it is not plotted, ensure that its text-
field is not highlighted in the Select data to show on graph
dialogue (black text on a white background). Double click on the
desired text-field with the pointer to de-select the curve.

When you have set up and selected all the curves you wish to
plot, click on OK. The dialogue will disappear from the screen,
and the curves will be plotted on the axes. An example is shown
in Fig.5.7.

Above the graph itself, when it is in Fit to Window mode, there
is an information section which shows the number of the sam-
pling channel from which the data for each curve was taken (1,
2, 3, etc.); the type of measurement (SF6, Temperature), the line-
style of the graph, the scale of the y-axis, and the unit of meas-
urement.

You can now process the curves of data to calculate measurement
parameters — see section 5.1.3.
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The Contents dialogue

Pull down the File menu and click on Contents. The Contents
dialogue is displayed, see Fig.5.8.

Chan is the number of the channel (from 1 to 12 plus one for
the User Program).

Fig.5.7 An example of a complete graph showing information on each
curve plotted
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First time is the date and time when measurements using that
channel were started for the first time. If a channel has not yet
been used in the database, n/a is shown.

Last time is the date and time when measurements using that
channel were stopped for the last time. If a channel has not yet
been used in the database, n/a is shown.

Active Filters (First Time) shows, using a black box, which filters
were used (A, B, C, D, E, W and Temperature (T) when a channel
was first used in a measurement in the database. In the same
way, it shows which of the 12 available channels for the User
Program were used when it was first used in a measurement in
the database.

The start and/or end times for the numeric or graphic displays
can be chosen by clicking on them followed by clicking on OK.
These times will then be transferred to the Graph Parameters
dialogue (see section 5.1.1).

Fig.5.8 The Contents dialogue
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5.1.3 Using the Graphic Window to Calculate 
Measurement Parameters

When you have plotted curves of your measurement results, you
can use the 7300 to process the data in the curves, and calculate
desired parameters. This is done by defining a region on your
curves of data using two cursors (allowing you to eliminate un-
typical measurements), and choosing the parameters you want
to calculate.

Before continuing with this section, make sure that the graphic
window is displaying the data you require, and that the panel
is displayed in the graphic window. If it is not, pull down the
View menu, and click on Show Panel.

Note: see Appendix C for further information about the param-
eters described below, and for details of how the 7300 performs
the calculations to obtain values for these parameters.

To define a region on the curves using the cursors:

1. If the complete graph is not shown in the graphic window,
click on Fit to Window in the panel.

The entire graph will be fitted into the size of the window.
This makes it easier to position the cursors on the curves.

2. Click on Cursor On in the panel.

Two vertical cursors will be displayed, Fig.5.9. To remove
the cursors, click on Cursor Off.

3. Move the mouse arrow onto the left cursor, and press and
hold the mouse button. Then drag the cursor to the position
you require. Repeat this procedure for the right cursor.

4. Click on Cursor Zoom.

The data-interval between the cursors will now be the entire
data-interval that can be seen.

You are now ready to select, and calculate, the parameters you
want.
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To define a region on the curves using the mouse:

1. Move the mouse arrow onto the upper left-hand corner of
the region you wish to zoom and press and hold the mouse
button. Then drag the arrow to the bottom right-hand corner
of the region you wish to zoom.

A box will be formed with one corner at the original position
of the mouse arrow when the button was pressed and the
opposite corner at the current position of the mouse arrow.

2. If you don't wish to zoom on this area, move the mouse
arrow back to the left or over its original starting position
and release the mouse button. The rectangle will disappear
and the mouse zoom function is cancelled.

Otherwise, release the button at the desired position for the
bottom right-hand corner of the region. The region of the
graph enclosed by the box will now be the entire graph that
can be seen.

3. To cancel the mouse zoom function, type in the original start
and end times in the Graph Set-up dialogue.

Fig.5.9 The cursors as they appear on the graphs
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Note: the mouse zoom will not function if the cursors are on.

To select parameters for calculation:

1. Click on Key Values in the panel. The Key Values dialogue
will be displayed, Fig.5.10. Parameters which cannot be se-
lected are indicated in grey.

This dialogue shows a list of parameters for which the 7300
can calculate values, using the data you have defined on
your curves of measurement results. You can select a max-
imum of 4 parameters at one time. The parameters in the
Key Values dialogue are explained in Appendix C.

2. Click on the parameters for which you want to calculate
values. The parameters you select will be identified by a
pointer.

Fitting chooses how much of the curve between the cursors
is used for calculating the extrapolation coefficient. If you
choose 33%, only the last third of the curve between the
cursors is used.

Fig.5.10 The Key Values dialogue
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If you select any of Time over y-value, Measurements
over y-value, Area between curve and y-value, type-in
the y-value that you require in the y-value field.

Under is used when you want to calculate the area under
a concentration-decay curve.

Over is used to calculate the area above a concentration-
growth curve.

Extrap extrapolates concentration-decay or concentration-
growth curves to infinity, allowing calculation of area, local
mean age-of-air, room average age-of-air, and air-exchange
efficiency from the extrapolated graph.

Graph bases the calculations of the key values on the entire
graph and not, as otherwise, on the section of the graph
between the cursors. It also allows you to display the key
values you choose, and their corresponding values, in prints/
plots of the graphic window.

3. When you have selected the parameters you want, click on
OK.

The Key Values dialogue will be removed from the screen.

You can now calculate values for the parameters you have se-
lected.

To calculate values for the parameters you have selected:

1. Pull down the View menu. Click on Show Values.

The Values Panel will be displayed at the top of the graphic
window, Fig.5.11.

The top section of the Panel displays the Key Values you
have selected. The lower section shows the x- and y-values
of where each cursor intersects the curves.

There is a Values Panel specific to each curve shown in the
graphic window. Each is labelled with the channel number,
measurement type and color for the curve. To see the values
display for another curve, click on Next to go forward, or
Prev to go backward.
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To remove the Values Panel, pull down the View menu and
click on Show Values.

2. In the Values Panel for each curve, click on Calculate.

The 7300 will calculate the values of the parameters dis-
played in the Values Panel. Refer to Appendix C for details
of how the 7300 calculates values for each of the parameters.

You can also "edit" data on the curves, to remove untypical data
from parameter calculations.

To edit data on the curves:

1. Move the two cursors to define the region of data that you
want to edit from the active curve (the one displayed in the
numeric window). The active curve is indicated in the Values
Panel, or by the arrow in the Select data to show on graph
dialogue.

2. Click on Data Edit in the panel. The Edit Data dialogue
will be displayed: click on Erase. If you want to restore the
data, click on Data Edit to display the Edit Data dialogue,

Fig.5.11 The Values Panel in the graphic window
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then click on Unerase. If you want to restore all the data
in the database, click on Data Edit to display the Edit Data
dialogue, then click on Unerase All.

You can change the display mode of the graph to Print mode in
preparation for future printing.

To change the display mode of the graph:

1. Click on Fit to Paper in the panel. The display mode chang-
es to Print mode and a section of the graph is displayed in
the window. A graph must be in Print mode if it is to be
printed. Only that which can be viewed through the window
will be printed. If the text in the graphic window is over-
lapping, this means that the page-size is too small, or the
type-size is too big. You can change these using the Printer
Setup in the File menu and Font function in the Set-up
menu.

2. To return to the Fit to Window mode to view the entire
graph, click on Fit to Window.

5.2 Using the Numeric Data Window

The numeric data window shows data in table form. It can show
the same types of data as the graphic window, but cannot be
used for calculating measurement parameters, etc.

To use the numeric window to display the data you require:

1. Pull down the View menu and click on Numeric window.
The numeric window will be displayed, Fig.5.12. Now make
the numeric window larger, using either the Size Box or the
Full Box icons on the numeric window.

2. Pull down the View menu again. Click on Show Panel.

A panel of "buttons" will be displayed on the left side of the
numeric window, Fig.5.12. These buttons are dedicated to
the numeric window, and are used to set-up the numeric
window to display the data you want. Show Panel is a
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toggle function: to remove the panel, pull down the View
menu and click on Show Panel again. 

3. Click on Graph Set-up in the panel. The Numeric Data
Interval dialogue will be displayed, see Fig.5.13.

X-interval selects the time-period which the display will
cover.

4. Type in the period of time that you want the numeric data
window to cover as described in step 3 of To set up the x-
interval and style of the graph, section 5.1.1.

Now proceed to select the data you want to display in the same
way as for the graphic window, using the Data Select button
in the panel. This is described in section 5.1.2. The arrow in the
selected text-fields in the Select Data dialogue indicates which
data will be displayed in the numeric window. To show different
data, click in another field to select it.

In addition to gas-measurement results which are always dis-
played, you can also display temperature data.

Fig.5.12 The numeric window showing measurement information
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To use the scroll function of the numeric window:

Click on Enable Scroll in the numeric window's panel, see
Fig.5.14.

This enables you to move through the data 10 records at a time.
To remove the scroll function, click on Disable Scroll in the
panel.

5.3 Using the Status Data Window

The status data window shows the current operating status of
the system. It informs you; what type of measurement is cur-
rently being performed; if any warnings or errors have occurred;
of the current date and time; and shows which alarms are active.
The status window can be displayed in two forms, a reduced
form and an extended form.

In the Status window, you can shut off alarms that have been
triggered by high gas concentrations.

Fig.5.13 The Numeric Data Parameters dialogue
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In its extended form, the status window displays the most recent
measurement results from a single or all measurement channels
(lower section of the window).

To activate the Status window:

1. Pull down the View menu and click on Status window.
The Status window will be displayed in reduced form. The
Status window for ventilation mode is shown in Fig.5.15.

2. To show the most recent measurement results from a par-
ticular measurement location, click on Select Channel.
Click on the number of the measurement channel from
which you want to display data. If you want to show data
from each active channel, as it is received from the instru-
ments, click on ALL CHANNELS.

The Status window will show the most recent measurement
results from the chosen measurement channel, or from each
active channel as the data is received, according to your
choice. The results are updated as each new result is re-

Fig.5.14 The numeric window with a panel showing the numeric scroll
bar
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ceived from the instruments. The extended Status window
is shown in Fig.5.16.

The extended form has the following fields:

Monitoring: shows if a measurement is currently active and the
name of the last active measurement location.

Select Channel: enables measurement results for a particular
location to be displayed. Activating this function produces the
extended form of the Status window.

The lower section indicates which channel is active; when
the measurement was made; when the next measurement
in that channel will start; the result and alarm limits for
each of the named gases; and the temperature.

Warnings/Errors: informs of any operating errors in the current
measurement. If an operating error has occurred, a letter (Flag)
is displayed. By clicking on View Warnings/Errors, a short
explanation (Flag-name) is given. For full details about these
Flags and Flag-names, see section D.1.

Current Time: shows the current time and date.

Fig.5.15 The Status window
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Alarms (press to shut off): shows if the alarms in the monitor
and multiplexer(s) are activated. To shut off alarms, see the
procedure described below.

To close the Status dialogue, use the normal Windows procedure
for closing windows.

To shut off alarms that have been activated:

In the Alarm (press to shut off) area, click on the alarms that
are active (On). This deactivates the alarms.

The alarms you click on will be shut off. An alarm that has been
shut off cannot be activated for the next 5 mins., even if the
lower alarm limit (the "warning" level) for that gas has been
exceeded. If, however, the upper alarm limit (the "danger" level)
is exceeded for any gas, the alarm will be activated.

Fig.5.16 The extended Status window
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5.4 Using the Notepad Window and 
the Comments Function

The notepad window allows you to make short notes about the
measurement in progress, the measurement set-up, and so on.
The text in the window is stored in the currently-open database
of the 7300.

You can also add a short text to the graphic window, using the
Comments function. The text you enter is transferred automat-
ically to the top right corner of the window, and is useful for
adding notes, observations etc. to printed/plotted documentation.

To use the notepad window:

1. Pull down the View menu. Click on Notepad window. The
notepad window will be displayed, Fig.5.17.

2. To edit existing or enter new text, position the cursor using
the mouse and type in the text you want.

Fig.5.17 The Notepad window
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3. When you have typed the text you require, close the window
using the normal windows procedures. The text is automat-
ically stored in the database.

To use the comments function:

1. Pull down the View menu. Click on Comments. The Com-
ments dialogue will be displayed, Fig.5.18.

The Comments dialogue has 4 lines, of maximum 32 char-
acters each. Type in the text you want. You can move the
cursor using the mouse.

2. When you have typed the text you require, click on OK.

The Comments dialogue will be removed, and the text you
have entered will be transferred automatically to the upper
right-hand corner of the graphic window when it is in the
“fit to paper” mode.

Fig.5.18 The Comments dialogue
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5.5 Printing/Plotting the Data 
Windows

The 7300's graphic and numeric windows can be printed/plotted
on a variety of devices. These are setup using normal Windows
procedures i.e. pull down the File menu and click on Printer
Setup.

Use the Print icon or pull down File and click on Print to
produce hard copies of the graphic and numeric windows.

Note: in order to plot/print graphic windows, the “Fit to Paper”
function must be selected in the graphic window.

If you wish to change the size or style of text used in the windows,
use the Font function.

Changing the Style and Size of Text:

1. Pull down the Set-up menu. Click on Font. The Select Font
dialogue will be displayed, Fig.5.19.

Font selects the typeface you want to use. A sample field
shows the current typeface and size.

Size selects the size of the chosen typeface. Choose the size
according to the page-size chosen in the Printer dialogue —
the larger the page size you have selected, the larger the
font you can use.

Note: the size of the text may be too large, resulting in some
of the words being overwritten.

2. Select the typeface and size that you want to use on-screen
and in prints/plots. An example of the typeface and size you
select is shown.

3. When you have selected the typeface and size you want,
click on OK.

The typeface and size you have selected will be used in the
graphic and numeric windows.

BB600412.book  Page 27  Saturday, January 10, 2004  1:03 PM



Chapter 5 – Displaying Measurement Data
Printing/Plotting the Data Windows

5 – 28 INNOVAApplication Software Type 7300
User Manual

The 7300 is now setup ready to print/plot the active graphic or
numeric window or the notepad which is open on the screen.

Fig.5.19 The Select Font dialogue
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COMPUTER REQUIREMENTS:
Hardware:
A Pentium II (333 MHz) processor or better
Min. 128 Mbyte RAM
Min. 20 Mbyte free space available on hard-disk
One serial port (RS–232) and one parallel port
or
One GPIB IEEE port and a parallel port
Mouse

Software:
Windows 98, NT (SP4.0 or above), Windows
2000 (SP1 or above)

DATA DISPLAYS:
Graphic:
Up to 6 curves, showing: gas concentrations; tem-
peratures; and data from external sources.
Numeric:
All measurement data can be displayed as tables.

DATA EXCHANGE CAPABILITY:
Data can exported to Database and Spreadsheet
programs, either using comma delimited files or
using Open Database Connectivity (ODBC) e.g.
Microsoft Access and Microsoft Excel

CALCULATION OF VALUES:
The 7300 can calculate the values of the following
parameters from the curves plotted from measure-
ment results:

Mean value of curve points
Spread of curve points
Minimum/maximum values on curve
Area under the curve
Weighted area under the curve
Time that the curve is over a given y-value
No. of measurements over a given y-value
Area under curve and over a given y-value.
Total area under extrapolated curve
Extrapolation coefficients
Air-exchange efficiency
Air-exchange efficiency with extrapolation
Local-mean age-of-air
Local-mean age-of-air with extrapolation
Room-average age-of-air
Room-average age-of-air extrapolation
8-hour mean value of curve points

BASIC SYSTEM REQUIREMENTS:
Gas Monitor (1 of).....1312/1312-1/1312-2/1314
1309 or 1303 Multipoint Sampler
Air Temperature Transducer (upto12) ..MM 0034
Personal Computer
Teflon Tubing
Cables:
From computer to monitor:
RS-232 cable 25/9 pin ......................... WL 0945
RS-232 cable 25/25 pin ....................... WL 0946
or
IEEE 488 cable .................................... AO 0265
From monitor to sampler:
IEEE 488 cable (0.4 m) ..................WL 0845/0.4
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This appendix tells you:

● How to delete existing databases from the 7300

● How to export data from, and import data to, the 7300

● How to back up databases, and restore databases to the 7300

A.1 Deleting Databases from the 7300

The Delete function in the File menu lets you delete databases
from the 7300.

Note: if you want to remove databases from the 7300, you must
use only this function. Otherwise, the 7300 cannot keep a record
of which databases are available to it.

Note: databases deleted from the 7300 cannot be undeleted. Be
sure that you want to delete the database before proceeding with
the Delete function.

To delete a database:

1. Ensure that all databases are closed.

2. Pull down the File menu. Click on Delete. The Delete Database
dialogue will be displayed, Fig.A.1.

3. Locate the file-name of the database you want to delete by
using the scroll arrows at the top and bottom of the list of
database files. Click on the file-name to highlight it.

4. Click on OK to delete the highlighted database.

5. Click on Yes to confirm or No to cancel.
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A.2 Exporting and Importing Data

The 7300's Export and Import functions are used for transfer-
ring data out of, and into, the 7300. Each function is dealt with
below.

A.2.1 Exporting Data Directly – using ODBC

Measurement data in the 7300 database is stored as a Microsoft
Access database. This is directly available to Microsoft Access
2000 or other software programs that support Open Database
Connectivity (ODBC).

The following programs can read the 7300 database:

Fig.A.1 The Delete Database dialogue

Programs Database Availability

Microsoft Access 2000 After measurements are completed
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7300 Database Structure

The following measurement data is contained in the 7300
database. It is structured in a table format:

A.2.2 Exporting Data – using ASCII Files

The Export function in the File menu enables you to produce
files ready for exporting from the 7300, for use according to your
requirements. The files produced are ASCII files, with data sep-

Microsoft Query 2000 While measurements are being 
made

Microsoft Excel 2000
Using “Get external data” function 
in Excel and while measurements 
are being made

Products that support 
ODBC

Refer to the individual programs 
instruction manuals

Monitoring Measurements:
monalrms : alarm data
monrec01 –airrec14 : measurement data channel 1–12 

+ 2 user channels
monsetrec : setup data
monsumrec : internal calculation table for  

SUM values
montxtrec : text data

Measurement data in monrecXX have the following format:
meas_0– meas_5 : measurement filter A – W (mg/m3)
min_0 –min_5 : min. measurement filter A – W (mg/m3)
max_0 –max_5 : max. measurement filter A – W (mg/m3)
Temp : temperature 10 × °K
Tim : time format; number of seconds from

01/01/1970 00:00 (see section B.3)

Programs Database Availability

BB600412.book  Page 4  Saturday, January 10, 2004  1:03 PM



Appendix A – Management of Databases and Data
Exporting and Importing Data

BB 6004 – 12 A – 5Application Software Type 7300
User Manual

arated by a character which you choose. The files to be exported
are placed in the directory of the chosen database. See section
B.2.2 of Appendix B for details of export file structures and file
names.

Note: this option is only available when measurements are not
running

To export data from the 7300:

1. Ensure that all databases are closed.

2. Pull down the File menu. Click on Export. The Export Data dialogue
will be displayed, Fig.A.2.

Database lets you select the database from which you want
to export data. The databases you can select depend upon
the current measurement mode.

Channels lets you choose the data you want to export by
selecting the appropriate sampling channels, therefore the
measurement locations. The boxes 1 to 12 represent the

Fig.A.2 The Export Data dialogue
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sampling channels of the 1303(s) or 1309. User represents
the data in the database from a user-program.

Separator selects the data-separator to be used in the files
that are to be exported.

Set-up lets you choose if set-up data is to be included in the
files to be exported.

3. Click on the name of the database from which you want to
export data. Then select the data to be exported from that
database by clicking on the appropriate box numbers.

4. Click on the type of data separator you want to use in the
export files. Choose if you want set-up data to be included
in the export file by clicking on either Yes or No.

5. Click on OK to begin exporting the data.

The data you have selected will be exported from the 7300 into
the directory of the chosen database. You can then use this data
according to your requirements. See section B.2.2 of Appendix B
for details of the file location and structures created by the
Export function.

A.2.3 Importing Data into the 7300

The Import function in the File menu lets you import data (e.g.
wind speed measurements) into the 7300 when no measurement
is running. The 7300 imports data from two ASCII files, the
header and the data file, and are the same type as those which
are used in the User Program function.

The files are imported by using an “item selector”, which lets
you choose the path to the files.

To import data to the 7300:

1. Pull down the File menu. Click on Import. The Import Data
dialogue will be displayed, Fig.A.3.

Import to Database lets you select the database into which
you want to import data, using the Items box. 
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Header File lets you choose the header file (see Appendix
B) to be imported. Clicking on this displays an item selector,
which you use to select the header file you want.

Data File lets you choose the data file (see Appendix B) to
be imported. Clicking on this displays an item selector, which
you use to select the data file you want.

Separator selects the data-separator used in the file to be
imported.

2. Click on the name of the database into which you want to
import data.

3. Click on Header File.

The Item Selector is displayed, Fig.A.4.

The Open dialogue shows the directories and files in the
same format as the operating systems File Manager. The
default extension of the type of file to be imported is “.TXT”.

Using the mouse, click on the drive and directories in the
path to the file name. 

Fig.A.3 The Import Data dialogue
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When you have the correct path and have selected your file,
as shown in the File Name field. Click on OK.

4. Click on Data file. Repeat the procedure in step 3 to select
the data file you want to import.

5. Click on the Separator “index card” and select character
separator used in the files to be imported.

6. Click on OK to begin importing the files you have selected.

The files you have selected will be imported into the database
you have chosen. The data you have imported can then be seen
in the data display windows as User Data (section 5.1.2).

A.3 Backing Up and Restoring Data

To safeguard data that you wish to keep and to save disk-space
in the computer, it is recommended that you back up databases
of older measurement results onto disks. You can also use this
function to store databases with special set-ups. You can restore

Fig.A.4 The Header file/Data file item selector
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the data from the disks if you want to use this data again. This
section tells you how to do this using the 7300's Backup and
Restore functions.

A.3.1 Backing up Data From the 7300

The Backup function in the File menu lets you back up data-
bases from the 7300. Note that a single database can contain
several disks-full of data, so before you begin backing up, ensure
that you have several formatted disks ready.

Note: Never back up more than one database on one disk or
drive.

To back up databases from the 7300:

1. Pull down the File menu. Click on Backup. The Backup
Data dialogue will be displayed, Fig.A.5.

2. Click on and highlight the database to be backed up. 

Fig.A.5 The Backup Data dialogue
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3. Click on OK. The Path dialogue is then displayed.

4. Using the mouse, click on the destination drive.

5. Click on OK to start backing up the chosen database.

The database will be backed up to the chosen destination. As
the back-up proceeds, the 7300 will display an alert telling you
when (if necessary) to change the back-up disks.

A.3.2 Restoring Data to the 7300

The Restore function in the File menu lets you restore backed
up databases to the 7300. Note that there must be enough space
on the computer's hard disk to accept the restored database. It
is recommended that you ensure you have enough space before
proceeding with this function.

This function makes it easier to set up a database with a stand-
ard set-up for a particular type of measurement by restoring an
empty database with the required standard set-up.

Important! You can only restore one database from one disk or
one drive.

To restore a backed up database to the 7300:

1. Pull down the File menu and click on Restore. The Restore
Data dialogue will be displayed, Fig.A.6.

2. Using the mouse, click on the drive of the database to be
restored.

3. Click on OK.

The database will be restored to the 7300. Note that you cannot
restore a backed up database to an existing database in the 7300
which has the same name. The existing database must be re-
moved if you wish to restore the backed up database to a data-
base with that name.
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A.4 Handling Databases from other 
7300 versions or after Re-installing 
the Software

The instructions in this section should be followed if you have
databases from other versions of the 7300 software, or you have
re-installed the current version, or if databases are moved from
one computer to another where the 7300 software is installed.

Note: these instructions apply to 7300 versions which run under
Windows™ and not older versions which run under GEM®Desk-
top™. Databases from GEM®Desktop™ versions can not be used
with the 7300 software supplied with this manual.

DO NOT COPY DATABASE FILES DIRECTLY INTO THE 7300
FILE STRUCTURE AS THIS PREVENTS YOU FROM CREAT-
ING THE NEW DATABASE WITH THE SAME NAME.

Databases are stored in the file structure as follows:

drive X:/.../7300/dbm/database name

Fig.A.6 The Restore Data dialogue
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After a new installation of the 7300, the software can not “see”
the existing databases in dba and dbm directories.

Restoring Existing Databases

If you are re-installing or updating the software, move your
databases out of the 7300 database file structure before contin-
uing. To enable the newly installed software to “see” the existing
databases, use the following instructions:

1. Pull down the File menu. Click on New. The New Database
dialogue will be displayed.

2. Type in the name of the existing database (max. 8 charac-
ters).

3. Click on OK to make and open the new database.

4. Pull down the File menu. Click on Close.

5. Repeat steps 1 to 4 if you want to restore some more data-
bases.

6. Pull down the File menu. Click on Exit. 

7. Start Windows file manager.

8. Check that the newly created databases exist in the file
structure:

drive X:/.../7300/dbm/database name/files

9. Copy the “original” database files into the newly created
databases in 7300 file structure.

The newly created files are overwritten by the “original”
ones, making the database files available to the 7300 soft-
ware.

Note: It may be necessary to set up the configuration and
the communication parameters again (see section 4.2 and
4.3).
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A.5 Using the Compress Data 
Function

The Compress Data function in the File menu is used to com-
press data in the current database. Compression is done by
reducing the measurement results in the database, and storing
these results in the place of the full set of data.

You can compress data from previous measurements in order to
release storage space in a database while keeping a record of
the measurement results. Thus, further measurements can be
added to the database. You can also compress data during a
measurement, when the available disk-space is full.

The compressed values are calculated as shown below:

Note:

● Data compression cannot be reversed once done. If you want
to keep all the original data, you must first make a back-
up of the database before doing the compression. See section
A.3.1 for details of how to do this.

Each 1312 optical 
filter:

The average, and the maximum and
minimum measured gas-concentra-
tions are stored.

Temperature: The average temperature measured
by each transducer.

Error flags: All error flags are stored.

Edited results: All edited results are ignored.

Time markers: The time marker given to the com-
pressed measurement result is that
for the last measurement result with-
in the time period.
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● Compressing data does not create more disk space. It merely
creates space within the database for further measurement
results.

To use the data compression function:

1. Pull down the File menu and click on Compress Data. The
Data Compressing dialogue will be displayed, Fig.A.7.

2. Click on the time period over which you want to reduce data.

For example, if you select 10 min., the measurement results
in the database will be “cut” into 10-minute sections, and
the results in each 10-minute period will be reduced as
described above. The reduced values will then be stored in
place of the full set of data for each 10-minute period.

3. Click on OK to begin compressing the data in the database.

Fig.A.7 The Data Compressing dialogue
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This appendix tells you:

● How to use the 7300's User Program function to import additional
data into the 7300 from an external program during a measurement

● The structures of the files which are used for transferring data into
and out of the 7300

B.1 The User Program Function

The User Program function in the Set-up menu lets you run
a program separate from the 7300, and import data from this
program into the 7300 while measurements are running. In this
way, you can import relevant data, such as air-velocity or hu-
midity, into the 7300 from a program which calculates such
values. User Program lets you select the program to be used,
and the header and data files into which the program writes the
data (therefore, the files from which the 7300 reads the data).
Details of the file structure to be used if the 7300 is to import
data generated by another program are given in section B.2.1 of
this Appendix.

When the User Program function is active, the 7300 creates
one ASCII file (the Export file) for each active measurement
channel (maximum 12 files) and creates or updates a single
ASCII file (the Info file) for all measurement channels after each
channel measurement is completed. Export Files contain the
most recent measurement results from each channel, and are
placed in the directory of the current database. The Info File
contains information about the relevant export file and is placed
in the 7300 directory. The external program is then activated by
the 7300. The program can then read the data from the ASCII
files (if necessary) and add the external data to the 7300 data.
Using this data, the external program must then create two
ASCII files – a header file and a data file – which are read by
the 7300, and the data imported into the current database as
User Data (up to 12 values).

BB600412.book  Page 2  Saturday, January 10, 2004  1:03 PM



Appendix B – Using External Programs, and File Structures for Data Transfer
The User Program Function

BB 6004 – 12 B – 3Application Software Type 7300
User Manual

To use the User Program function:

1. Pull down the Set-up menu. Click on User Program. The User
Program dialogue will be displayed, see Fig.B.2.

Program enables you to choose the user program, and the
path to the program.

Header enables you to choose the header-file into which the
user program writes header information. The header-file
must exist before the 7300 is started, otherwise it cannot
be chosen.

Data enables you to choose the data-file into which the user
program writes the measurement data. The data-file must
exist before the 7300 is started, otherwise it cannot be cho-
sen.

Fig.B.1 Use of the User Program function
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Separator lets you select the data-separator character used
in the files generated by the user program.

2. Click on Program. 

Directories displays the current directory, and shows the
default extension of the user program and the type of file
to be imported (.EXE, .COM or .BAT). Using normal win-
dows procedures, browse through the file structure to find
the user program. 

3. Click on OK when you have selected the program you re-
quire. The path and the name of the user program you have
selected will be displayed in the field under Program.

4. Click on Header. 

5. Click on OK when you have selected the file you require.
The path and the name of the file you have selected will be
displayed in the field under Header.

6. Click on Data.

Fig.B.2 The User Program dialogue
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7. Click on OK when you have selected the file you require.
The path and the name of the file you have selected will be
displayed in the field under Data.

8. Click on the separator character used in the data to be
imported.

9. Click on OK to store the user program set-up you have made.

When measurements begin, the 7300 will run the chosen pro-
gram, and import data from the files created by the program as
described above, after each sampling channel measurement. The
data will be placed in the database as User Data (section 5.1.2).

B.2 File Structures for Data Transfer

The User Program, Import, and Export functions of the 7300
allow data to be transferred to and from the 7300. User Pro-
gram allows transfer while measurements are running. Import
and Export are used when no measurements are running (see
section A.2). The 7300 uses ASCII files to exchange data. The
structures of these files are described in the following text: first,
the structures of the files used by the User Program function
and the Import function; secondly, the structures of the files
used by the Export functions.

B.2.1 File Structures Used by the User Program 
Function and the Import Function

The User Program function uses two types of import files
(Header and Data files) and two types of export files (Info and
Export files). The Import function uses the same types of import
files as the User Program function but does not use export files.

Export files:

The User Program function creates an ASCII Export file for
each active measurement channel (therefore, a maximum of 12
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files). These files are always in the directory of the database
currently in use, i.e.:

Drive:\7300\dbm\Database name

The files always have the same name:

BKMONM1.EXP, BKMONM2.EXP,....BKMONM12.EXP

If a measurement channel is not being used, no file will be
generated for that channel.

Export files:

Export files contain the following data in the following order. All
the data is contained in the same line, separated by the chosen
separator character:

6 real values (measurement results from the 6 filter positions of
the 1312)

1 whole number (temperature as measured by temperature
transducer)

1 whole number (time of the measurement in Excel time for-
mat), see section B.3

Example (separator character: “,”):

2.300000,2.500000,0.000000,0.000000,10.200000,2.480000,24,35314.438727

Note that each time the 7300 receives new data from the 1312
and 1303 or 1309, the data in these files is deleted and replaced
by the new data. Therefore, the files always contain the most
recent measurement results for use by the user program.

Info file:

The User Program function also creates an ASCII Info file
(7300.EXP) in the 7300 directory which can be used by the User
Program to identify the Export file. The Info file has the following
format:

Export file name,n/a,database name,[FIRST]

Export file name is the name of the current Export file.
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n/a the value displayed is not applicable here. 

Database name is the name of the database where the Export
file is to be found.

FIRST appears if this is the first time that this Export file has
been used in this measurement.

Example:

BKMONM6.EXP,1,BUILDX,FIRST

The current Export file is BKMONM6.EXP in the BUILDX da-
tabase. FIRST shows that this is the first time the file has been
used since starting the measurement. The number 1 is not ap-
plicable.

When the user program has performed its function, it must
create two files so that the 7300 can read the data: the header-
file and the data-file. The header-file tells what, and how much
is in the data-file; the data-file contains the data itself. The 7300
reads the information from these files. The files, like the user
program, can be placed in any directory on the computer's hard
disk, as the User Program function sets a path to the program
and the files. The formats given below are also appropriate when
using the Import function, section A.2.2.

The files are written in the following format.

Header file:

time-format,n,unit 1, ... ,unit x,set-up text

time-format gives the format in which the time is written in the
data file. There are two time formats:

“S”, in which the time is written as a 16-character string,
for example:

“19900716143035” (“YYYYMMDDHHMMSS”)

“N”, in which the time is written in Excel time format (see
section B.3)

n is the number of measurements (channels) in the data file,
from 0 (if nothing is being imported) to 12.
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unit x is the unit of measurement number x, as shown in Table
B.1.

set-up text is a text-string describing the data. The string is
enclosed by “x” marks, and has a maximum of 15 characters.

Example:

“N”,2,12,12,“Wind-speed”

The time is written in Excel time format. There are 2 meas-
urements in the data file. The unit for each measurement is m/s.

Data file:

measurement 1,measurement 2,measurement 3,...,measurement n,time

measurement x is the value of measurement x.

time is the time for the data in the data file, written in the
format given by time-format above.

Example:

3.5,4.2,35314.438727

The value from the first measurement is 3.5. The value from
the second measurement is 4.2. The time is in “N” format and
is 1996-09-06 10:31:46.

The header and data file are read by the 7300 after each channel
measurement, and the data is placed in the currently-open da-
tabase as User Data. The files can also be read-in to the 7300
using the Import function, and are placed in the chosen database
in the same way.

Note: more than one line at a time can be read-in to the 7300
using the Import function.

B.2.2 File Structures Used by the Export Function

The Export function creates ASCII files, containing measure-
ment data and set-up data (if chosen) from a database, which
can then be used by other programs. Export creates one file for
each measurement channel (maximum 14 files, as two files for
User Data can be made) and a file for the complete measurement
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set-up (if chosen) of that database. The export files are placed
in the directory of the database from which the data is taken.

The files always have the same name:

BKMMALSE.TXT (set-up data); BKMONM1.TXT ...
BKMONM14.TXT (measured data)

Note: a file for the database's set-up data is made only if you
chose to do so in the Export dialogue, section A.2.1.

Value Unit of Measurement

0
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28

No unit
ppm

mg/m3

g/m3

kPa
mBar

mmHg
K
C
F
m

feet
m/s

dewpoint
vapour pressure

relative humidity
W/m2

%
PMV

W
kWh

l/s
m3/s
m3/h

ft3/min
degrees

dB
LUX
N/A

Table B.1 The units of measurement represented by the value
of “unit x”
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Structure for set-up data files:

The structure of set-up data files is as follows.

Name of database.
Type of measurements:

5 or 6 → Monitoring
Filter A used/unused. (0 if unused, 1 if used)
Filter B used/unused. (0 if unused, 1 if used)
Filter C used/unused. (0 if unused, 1 if used)
Filter D used/unused. (0 if unused, 1 if used)
Filter E used/unused. (0 if unused, 1 if used)
Filter W used/unused. (0 if unused, 1 if used)
Gas-name from 1312 for optical filter A
Gas-name from 1312 for optical filter B
Gas-name from 1312 for optical filter C
Gas-name from 1312 for optical filter D
Gas-name from 1312 for optical filter E
Molecular weight of gas A
Molecular weight of gas B
Molecular weight of gas C
Molecular weight of gas D
Molecular weight of gas E
Molecular weight of gas W
Ki,c (const. conc. 1)
Kp (const. conc. 1)
Ki,n,v (const. conc. 1)
Kd (const. conc. 1)
Ki,n,s (const. conc. 1)
KL (general)
MAXACH (const. conc. 1)
I0 (const. conc. 1)
Ta (general)
Cb (general)
Ki,c (const. conc. 2)
Kp (const. conc. 2)
Ki,n,v (const. conc. 2)
Kd (const. conc. 2)
Ki,n,s (const. conc. 2)
KL (general)
MAXACH (const. conc. 2)
I0 (const. conc. 2)
Ta (general)

BB600412.book  Page 10  Saturday, January 10, 2004  1:03 PM



Appendix B – Using External Programs, and File Structures for Data Transfer
File Structures for Data Transfer

BB 6004 – 12 B – 11Application Software Type 7300
User Manual

Cb (general)
Measurement Location text (location 1)
Measurement Location text (location 2)
Measurement Location text (location 3)
Measurement Location text (location 4)
Measurement Location text (location 5)
Measurement Location text (location 6)
Measurement Location text (location 7)
Measurement Location text (location 8)
Measurement Location text (location 9)
Measurement Location text (location 10)
Measurement Location text (location 11)
Measurement Location text (location 12)
Not applicable
Not applicable
Not applicable
Not applicable
Not applicable
Not applicable
Alarm limit for filter A (from Alarms dialogue)
Alarm limit for filter B (from Alarms dialogue)
Alarm limit for filter C (from Alarms dialogue)
Alarm limit for filter D (from Alarms dialogue)
Alarm limit for filter E (from Alarms dialogue)
Alarm factor (from Alarms dialogue)
Path to User Program
Location Room-vol., location 1 (from Multiplexer dialogue)
Location Room-vol., location 2 (from Multiplexer dialogue)
Location Room-vol., location 3 (from Multiplexer dialogue)
Location Room-vol., location 4 (from Multiplexer dialogue)
Location Room-vol., location 5 (from Multiplexer dialogue)
Location Room-vol., location 6 (from Multiplexer dialogue)
Location Room-vol., location 7 (from Multiplexer dialogue)
Location Room-vol., location 8 (from Multiplexer dialogue)
Location Room-vol., location 9 (from Multiplexer dialogue)
Location Room-vol., location 10 (from Multiplexer dialogue)
Location Room-vol., location 11 (from Multiplexer dialogue)
Location Room-vol., location 12 (from Multiplexer dialogue)
Pressure (from Monitor dialogue)
Temperature (from Monitor dialogue)
Compensation:

1 = cross-compensation
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16 = water compensation
17 = cross + water compensation

Time between measurements
Number of 1303 units in the system
Target concentration for tracer-gas A
Target concentration for tracer-gas B
Molecular weight of tracer-gas A
Molecular weight of tracer-gas B
Unit code for imported data (see table B.1, user data 1)
Unit code for imported data (see table B.1, user data 2)
Unit code for imported data (see table B.1, user data 3)
Unit code for imported data (see table B.1, user data 4)
Unit code for imported data (see table B.1, user data 5)
Unit code for imported data (see table B.1, user data 6)
Text for imported data

Structure for measured data files:

The structure of measured data files is as follows:

Average gas-concentration measured by Filter A
Average gas-concentration measured by Filter B
Average gas-concentration measured by Filter C
Average gas-concentration measured by Filter D
Average gas-concentration measured by Filter E
Average concentration measured by Filter W
Minimum concentration measured by Filter A
Minimum concentration measured by Filter B
Minimum concentration measured by Filter C
Minimum concentration measured by Filter D
Minimum concentration measured by Filter E
Minimum concentration measured by Filter W
Maximum concentration measured by Filter A
Maximum concentration measured by Filter B
Maximum concentration measured by Filter C
Maximum concentration measured by Filter D
Maximum concentration measured by Filter E
Maximum concentration measured by Filter W
Accept/no accept of results from Filter A

0 → accept
1 → no accept

Accept/no accept of results from Filter B
Accept/no accept of results from Filter C
Accept/no accept of results from Filter D
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Accept/no accept of results from Filter E
Accept/no accept of results from Filter W
Accept/no accept of air value
Accept/no accept of temperature
Temperature measured
Time of measurement, expressed in Excel time format
Status information

B.3 Description of Time and Date
Formats in the 7300

The 7300 software uses two time formats: database time format
and data file time format.

B.3.1 Database Time Format

Databases use a time format that shows the time as the number
of seconds since 01-01-1970 00:00.

For example: 842005734 = 14033429 mins. = 233890.5 hours =
26.7 years since 01-01-1970 00:00

= 06-09-96 10:28

B.3.2 Data File Time Format

Data files use the Excel time format. This is a decimal number,
where the whole number is the number of days from 01-01-1900,
while the decimal part is the relationship to the total number
of seconds in 24 hours.
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Example:

B.3.3 Converting the Time Formats using Excel

The time data formats produced by the 7300 program can be
easily converted in to calendar dates by a Spreadsheet program,
in this case Excel, using the following procedure.

1. Make a spreadsheet similar to that in Fig.B.3.

2. In cell A2 type in the time in seconds from 01-01-1970

3. In cell B2, the seconds are converted to Excel time format
using the formula shown in Fig.B.3 and presented as a
numeric (Format, Cells, Number).

4. In cell C2, enter again the formula line shown in Fig.B.3.
The Excel time format is then displayed as a calendar date
by selecting Format, Cells, Custom and dd-mm-yy
hh:mm.

Note: If you have problems converting the time, check that the
Regional Settings are the same as those in the system computer.

34632.6423843

34632/365
= 94.88 years

0.6423843×86400
= 55502 seconds
= 925.03 mins
= 15.41 hours

= 25-10-94 15:25:02.0
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Fig.B.3 Converting Time formats using Excel
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C.1 Calculating Key Values

This section shows the methods used by the 7300 to calculate
values for the parameters in the Key Values dialogue (see
Fig.C.1). The 7300 uses data displayed in the Graphic Window
(see section 5.1.3). Two cursors are used to define the interval
of the curves that will be used for calculating values for the
parameters. If the cursors are not used, calculations are per-
formed using all of the data that can be seen on the curve if
Graph is activated on the Key Values dialogue. If Graph is not
activated on the Key Values dialogue and the cursors are not
used, no calculations are performed.

There are three typical gas-concentration vs. time curves. These
are shown in Fig.C.2.

The following symbols, denoting points on the curves of meas-
urement results, are used in the following calculations:

C-1 refers to the gas concentration immediately to the left
of cursor number 1

Fig.C.1 The Key Values dialogue
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T0 , C0 refer to the first measurement time and gas concentra-
tion in the cursor interval, respectively

Ti , Ci refer to a measurement time and gas concentration
within the cursor interval, respectively

TN-1 ,CN-1refer to the last measurement time and gas concentra-
tion in the cursor interval, respectively

t=0 , tend are the times at the first and second cursors, respec-
tively

∆ti is the time interval between two consecutive measure-
ments (i.e. Ti+1 – Ti)

The calculations performed by the 7300, using the data from the
three typical curves, are described in the following three sections.

C.1.1 Values Calculated for All Types of Curves

The following can be calculated irrespective of the type of curve.

Minimum value in the cursor interval:

Minimum value = minimum (Ci)

Maximum value in the cursor interval:

Maximum value = maximum (Ci)

If the cursors are not placed directly over a measured value on
the time axis, the 7300 uses the value of the measurement
immediately to the left of the cursors, as shown in Fig.C.3

Mean value of points in the cursor interval:

where N = Number of valid measurements within the cursor
interval

Mean Ci N⁄( )
i 0=

N 1–

∑=
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Fig.C.2 The three types of gas-concentration/time curve from which the
7300 can calculate Key Values
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Spread of values:

8 hours mean value:

This value is only calculated for Channel Data (one sampling
channel) and not for Mean Data (average of several channels)

Fig.C.3 Correcting for the positions of the cursors and definitions for the
calculations of areas
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where:

C = Gas concentration

N8 = Number of valid measurements in the 8 hour interval

Total time where C is greater than or equal to the y-value,
Clevel :

Number of measurements over or equal to the y-value,
Clevel :

Area between curve and a given y-value, Clevel:

“Area” under the curve (negative for any part of the curve
below y =0):

Time ∆ti
C Clevel>
∑=

Number M=

Area Cavei Clevel–( ) ∆ti⋅
C Clevel>
∑=

C t( ) dt⋅
0

tend

∫ ai b1 b2+ +

i 0=

N 2–

∑≈
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where b1 (C-1.T0) and b2 (CN-1.(tend-TN-1) are the end correction
factors defined in Fig.C.3.

Weighted area under the curve (1st moment):

where b1,w is 

and b2,w is  are the weighted end

correction factors corresponding to b1 and b2, respectively.

Area Cavei
∆ti C 1–+ T0 CN 1–+ tend TN 1––( )⋅ ⋅ ⋅

i 0=

N 2–

∑=

C t( )
0

tend

∫ tdt⋅ ai

i 0=

N 2–

∑ Ti
1
3
---∆ti

1
3
---

Ci 1+

Ci 1+ Ci+
------------------------- ∆ti⋅+ + 

 ⋅ b1 w, b2 w,+ +≈

1
3
---C 1– T0 T0 1

C0
C0 C 1–+
-----------------------+

 
 
 

⋅ ⋅ ⋅

1
2
---CN 1– tend( TN 1–– ) tend( TN 1–+ )⋅ ⋅

W.Area Cavei

i 0=

N 2–

∑ tave i
∆ti

1
3
---C 1– T0 T0 1

C0

C0 C 1–+
----------------------+ 

 

1
2
---CN 1– tend TN 1––( ) tend TN 1–+( )⋅ ⋅+

⋅ ⋅ ⋅+⋅ ⋅=

where tave i
Ti 1 3⁄ ∆ti 1 3⁄

Ci 1+

Ci 1+ Ci+
-------------------------- ∆ti⋅+ +=
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C.1.2 Special Calculations for Concentration-decay 
Curve

“Area” under the extrapolated curve (negative for any
part of the curve below y=0):

Fig.C.4 Concentration-decay curve
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where α is the slope of the concentration decay based on the
decay between tf and tend

This can also be expressed as: 

Weighted area under the extrapolated curve:

This can also be expressed as:

Local age-of-air without extrapolation:

Local age-of-air with extrapolation:

Room-average age-of-air without extrapolation:

Room-average age-of-air with extrapolation:

Areaex 1 α⁄ CN 1– Area+⋅=

W.Areaex C0
tend

∞

∫ eαt tdt W.Area+⋅=

W.Areaex 1 α⁄ CN 1– tend( 1 α⁄ ) W.Area+ +⋅ ⋅=

Local age
Area
C 1–
-----------=

Local age
Areaex

C 1–
----------------=

Average age
W.Area

Area
------------------=

Average ageex

W.Areaex

Areaex
-----------------------=
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Air-exchange efficiency without extrapolation:

Air-exchange efficiency with extrapolation:

Extrapolation coefficient 1 in the last part of the cursor
interval defined by Fitting:

where all summations are made from tf to tend

where Fitting is obtained from the Select Key Values dialogue

Note: the part of the cursor interval on which the extrapolation
coefficient is based is determined by the actual cursor positions
and the Fitting %, and not by T0 and TN-1, respectively the first
and last measurements within the cursor interval.

Fitting:

See section 5.1.3.

Efficiency
Local age

2 Average age⋅
-------------------------------------=

Efficiencyex

Local ageex

2 Average ageex⋅
------------------------------------------=

Slope coefficient α
N t∑ ln C( ) t∑ ln C( )∑⋅–⋅ ⋅

N t2
∑ t∑( )

2
–⋅

-----------------------------------------------------------------------------= =

tf tend
Fitting

100
----------------tend–=
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C.1.3 Special Calculations for Concentration-
growth Curves

k1, k2 and k3 are estimated from the curve in the curve fitting
interval (see Fig.C.5) using curve fitting for non-linear expres-
sions.

k1 is equivalent to C∞ , the Infinity Value Curve on the Select
Key Values dialogue.

k2 is equivalent to Extrapolation Coefficient 1 on the Select Key
Values dialogue.

Fig.C.5 Concentration-growth curve
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k3 is equivalent to Extrapolation Coefficient 2 on the Select Key
Values dialogue.

“Area” above the curve, until CN-1 (negative for any part
of the curve below y=0):

which can be expressed as:

where Area is the area under the curve (see section C.1.1).

Area above the curve and extrapolated curve, until
C∞(k1):

which can expressed as:

Weighted area above the curve, until CN-1:

therefore 

where W.Area is the weighted area under the curve (1st moment,
see section C.1.1).

Area over CN 1– k1 k2e
k3t–

–( )–( ) td
0

tend

∫=

Area over CN 1– tend Area–⋅≈

Area overex k1tend Area k1 k1 k2e
k3t–

–( )–( )dt
tend

∞

∫+–=

Area overex k1tend Area k( 2 k3 )e
k– 3tend⁄+–≈

W.Area over CN 1– k1 k2e
k– 3t

–( )–( )tdt
0

tend

∫=

W.Area over 1 2⁄ CN 1– tend
2

W.Area–⋅≈
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Weighted area above the curve and extrapolated curve,
until C∞ (k1):

where W.Area is the weighted area under the curve (1st moment,
see section C.1.1).

therefore 

Local age-of-air without extrapolation:

Local age-of-air with extrapolation:

Room-average age-of-air without extrapolation:

Room-average age-of-air with extrapolation:

W.Area overex 1 2⁄ k1 tend
2 k1(

tend

∞

∫ k1 k2– e
k– 3t

+( ) )– tdt W.Area–+⋅=

W.Area overex 1 2⁄ k1 tend
2 k( 2 k3 ) e

k– 3tend tend 1 k3⁄+( ) W.Area–⋅ ⋅⁄+⋅≈

Local age over
Area over

CN 1–
-----------------------=

Local age over
Area overex

k1
----------------------------=

Average age over
W.Area over

Area over
-------------------------------=

Average age overex

W.Area overex

Area overex
-----------------------------------=
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Air-exchange efficiency without extrapolation:

Air-exchange efficiency with extrapolation:

Infinity value curve:

Infinity value curve = k1 (C∞)

Extrapolation coefficient 1:

Extrapolation coefficient 1 = k2

Extrapolation coefficient 2:

Extrapolation coefficient 2 = k3

Efficiency
Local age over

2 Average age over⋅
-------------------------------------------------=

Efficiencyex

Local age overex

2 Average age overex⋅
------------------------------------------------------=
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D.1 Warning/Error/Status Flags

The flags used by the 7300 to indicate the system's operating
status can be seen in the 7300's status window and the numeric
window. The flags are divided into 7300, 1312 and 1303 or 1309
flags. These are defined as follows:

Note: The 7300 flag is not shown in the numeric window or in
the Warnings/Errors view in the status window, but the status

Flag Flag-name Flag Priority Generated by Bit no.

7300:
D
A
C
R

Data Edit flag
Alarm limit exceeded
Communication error
Reboot

No priority
1 (Mon. mode only)
2
3

0
1
2
3

1312:
A
B
E
W
M
P
V

Airway error
Bad result
Equipment failed
Equipment Warning
Mechanical error
Power failure
Vibration too high

5*
6
1
2
3
7
4

S2

4
5
6
7
8
9
10

1303 
or 
1309:

D
E
G
P
S

Dosing pump weak
Equipment failed
Gas pressure
Power failure
Sample channel 
blocked

2 (Vent. mode only)
1
4 (Vent. mode only)
5
3*

W7
E1;E2;E3;E7;W2
E5
W1; W3
E4

11
12
13
14
15

Table D.1  The Warning/Error/Status flags used in the 7300
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window opens automatically and the alarms are activated when
the alarm limits are exceeded.

When a flag is set, the relevant bit is set to 1. When a flag is
not set, the relevant bit is set to 0. A series of these bit settings
makes up a binary word with the most significant bit being
no. 15. The decimal equivalent, made up from this binary word,
is used as the status information in the 7300 Export function
(see Appendix B.2.2).

The priority of the flag is used in the Status window, where
there is room to display two simultaneous errors for each of the
7300, 1312 and 1303 or 1309. If there are more errors than this,
the two flags of highest priority are displayed. A full list of errors
can be seen in the Numeric window.

The notation used in Table D.1 is as follows:

E1, E2, E3, E4, E5, E6 and E7 refer to bits 1 to 7 of the
1303 or 1309 Error Flags, see section D.1.3 and D.1.4.

W1, W2, W3, and W7 refer to bits 1, 2, 3 and 7 of the 1303
or 1309 Warning Flags, see section D.1.3 and D.1.4.

S2 refers to bit 2 of the 1312 Status Byte, see section D.1.2.

* means that if these errors arise, you will hear a beep from
the PC-speaker, and three beeps from the 1312 speaker. This
is because these errors are hard to identify unless the Error/
Warning flags are read, and are errors which can affect
measurements.

The meaning of each individual flag is described in the following
three sections.

D.1.1 The 7300 Flags

Data Edit is generated when you have edited measurement
results using the 7300's Data Edit function. This flag is not
shown in the status window.

Alarm Limit ex. is generated by the 7300 when a gas-concen-
tration exceeds the specified alarm limits. This flag is not shown
in the numeric window or in the Warnings/Errors view in the
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status window. But the status window opens automatically and
the alarms are activated when the alarm limits are exceeded. 

Communication Error is generated by the 1303 Error flag
“Job Specification Error” E6, or if the 7300 has aborted commu-
nication with the instruments.

Reboot is generated by the 7300 if it registers that power was
cut off during a measurement.

D.1.2 The 1312 Flags

Note: for further information about the 1312 Warning and Error
flags mentioned below, please refer to the 1312 Instruction Man-
ual.

Airway Error is generated by the “Air Shunt Blocked. Sample
aborted” A2, “Air Flow Too Low” or “Airway System Blocked”
incidents. These errors cause the PC speaker to beep, and give
three beeps from the 1312's speaker.

Bad Result is generated by the 1312 when corrupted measure-
ment results are read from the 1312 to the 7300. The results
are set to 0 and are automatically edited out to ease calculation
of the Key Values. They can be edited back in again.

Equipment Failed is generated by the “A/D Interrupt Failed”,
“Internal Temperature Out Of Range”, “Internal Program Error
Found”, “No Index-Mark from Filter Carousel” or “Power Supply
Voltage Out Of Range” incidents.

Equipment Warning is generated by the “Back-up Battery
Low”, “Error Detected In Clock Settings”, “Error Detected in
Calibration Factors”, “Error Detected in Source Memory”, “Error
Detected in Background Memory”, “Error Detected in Config./
Format Parameters”, “Error Detected in Task-Setup Parameters”
or “Error Detected In Internal Memory” incidents.

Mechanical Error is generated by the 1312 Error flags “Chop-
per Failed”, “IR-Source Temperature Out Of Range”, “Micro-
phone Test Failed” or “Pump Test Failed” incidents.
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Power Failed is generated by the 1312 Error flag “Reset Acti-
vated”, which is set when power has been cut to the 1312.

Vibration Too High is generated by the 1312 Error flag “Vi-
bration Level Too High”.

D.1.3 The 1303 Flags

Note: for further information about the 1303 Warning and Error
flags mentioned below, please refer to the 1303 Instruction Man-
ual.

Equipment Failed is generated by one or more of the 1303
Error flags “ADC flag” E1, “RAM Flag” E2, “PROM Flag” E3,
“Software Error Flag” E7, or the Warning flag “Temperature
Flag” W2.

Gas Pressure is generated by the 1303 Error flag “Dosing Pres-
sure Flag” E5.

Power Fail is generated by the two 1303 Warning flags “Reset
Done Flag” W1 or “Power Fail Flag” W3.

Sampling Chan. Blocked is generated by the 1303 Error flag
“Sampling Channel Flag” E4.

D.1.4 The 1309 Flags

Note: for further information about the 1309 Warning and Error
flags mentioned below, please refer to the 1309 Instruction Man-
ual.

Equipment Failed is generated by one or more of the 1309
Error flags “ADC flag” E1, “RAM Flag” E2, “PROM Flag” E3,
“Software Error Flag” E7, or the Warning flag “Temperature
Flag” W2.

Gas Pressure is generated by the 1309 Error flag “Dosing Pres-
sure Flag” E5.
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Power Fail is generated by the two 1309 Warning flags “Reset
Done Flag” W1 or “Power Fail Flag” W3.

Sampling Chan. Blocked is generated by the 1309 Error flag
“Sampling Channel Flag” E4.
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